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Abstrak
 

____________________________________________________________ 
Tantangan pengelolaan sumber daya manusia sering dihadapi dalam proyek konstruksi, 
dan perataan sumber daya manusia adalah metode efektif untuk mengatasi fluktuasi 
penjadwalan konstruksi. Penelitian ini bertujuan mengidentifikasi strategi perataan 
sumber daya manusia efektif dalam pembangunan drainase pengendali banjir di Kota 
Palangka Raya dan menganalisis dampaknya terhadap efisiensi penjadwalan dan 
penyelesaian proyek. Metode ini mengurangi jumlah sumber daya manusia tanpa 
mengorbankan penyelesaian proyek, mempercepat penyelesaian tanpa mengurangi 
kualitas. Metode perataan sumber daya pada perencanaan sumber daya manusia proyek 
dapat menghasilkan grafik kebutuhan tenaga kerja yang optimal dibandingkan dengan 
grafik kebutuhan awal yang fluktuatif. Pada proyek ini, sebelum dilakukan perataan, 
jumlah sumber daya adalah 1023 OH, setelahnya menjadi 925 OH, berkurang sebesar 
9,58%. Pada jenis pekerja, tukang, kepala tukang, dan mandor, jumlahnya mengalami 
penurunan yang signifikan, sehingga sumber daya menjadi lebih terkontrol. Meskipun 
jumlahnya berkurang, penyelesaian proyek dapat dipercepat 42 hari dari 300 hari yang 
direncanakan menjadi 258 hari. 

Abstract
 

____________________________________________________________ 
Human resource management challenges are often faced in construction projects, and human resource 

leveling is an effective method to overcome construction scheduling fluctuations. This study aims to 

identify effective human resource leveling strategies in the construction of flood control drainage in 

Palangka Raya City and analyze their impact on the efficiency of project scheduling and completion. 

This method reduces the number of human resources without sacrificing project completion, 

accelerating completion without reducing quality. The resource leveling method in project human 

resource planning can produce an optimal labor requirement graph compared to the initial fluctuating 

requirement graph. In this project, before leveling, the number of resources was 1023 OH, after which 

it became 925 OH, a reduction of 9.58%. In the types of workers, masons, head masons, and foremen, 

the number has decreased significantly, so that resources become more controlled. Despite the reduced 

number, the project completion can be accelerated by 42 days from the planned 300 days to 258 days.  
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PENDAHULUAN 

Kota Palangka Raya memiliki tingkat kerentanan tinggi terhadap bencana alam, terutama 

banjir, yang dapat menimbulkan kerugian besar bagi kehidupan dan mata pencaharian masyarakat 

(Ariyadi et al., 2023; Setiawan, 2022; Triwibowo, 2023). Sistem drainase sebagai infrastruktur penting 

berperan vital dalam mengurangi risiko banjir dan mendukung perencanaan perkotaan (Lendra et al., 

2023). Dalam pelaksanaan proyek konstruksi, sering muncul berbagai kendala, termasuk keterbatasan 

tenaga kerja sebagai sumber daya manusia  (Satic et al., 2022). Tenaga kerja merupakan faktor kunci 

keberhasilan proyek, namun jumlah dan kualitasnya yang terbatas sering menjadi tantangan utama 

(Retno et al., 2018). Oleh karena itu, dibutuhkan perencanaan tenaga kerja yang cermat, mencakup 

estimasi jenis, jumlah, disiplin, keahlian, serta distribusinya di setiap tahap proyek (Mulyono et al., 

2020). Fluktuasi dalam ketersediaan sumber daya manusia menciptakan tantangan serius dalam 

penjadwalan konstruksi, menghasilkan ketidaksesuaian antara kebutuhan dan profil tenaga kerja yang 

diinginkan (Lendra et al., 2025). Kesenjangan yang ditemukan pada studi kasus ini menunjukkan 

pentingnya penerapan pendekatan manajemen sumber daya manusia yang tepat. Oleh karena itu, 

diperlukan analisis mendalam untuk menyelaraskan pemanfaatan tenaga kerja yang terbatas dan 

fluktuatif agar proyek berjalan optimal dan terkelola dengan baik.  

Perataan sumber daya (resource levelling) tenaga kerja merupakan pendekatan yang efektif 

untuk mengatasi fluktuasi tenaga kerja dalam penjadwalan proyek konstruksi. Teknik manajemen 

proyek ini bertujuan mengatasi kelebihan alokasi atau konflik penjadwalan dengan memastikan 

penyelesaian proyek sesuai batas waktu dan anggaran yang ditetapkan (Lim et al., 2007). Metode ini 

menekankan penggeseran aktivitas non-kritis dalam rentang waktu yang tersedia tanpa mengubah 

durasi proyek secara signifikan (Yani et al., 2015). Dengan demikian, perencanaan tenaga kerja dapat 

dikelola lebih efisien melalui penyesuaian antara kebutuhan dan ketersediaan tenaga kerja. Selain itu, 

proses perataan sumber daya memerlukan identifikasi sumber daya terbatas yang dibutuhkan sepanjang 

proyek untuk menentukan prioritas alokasi secara tepat (Hartati, 2017). Penelitian ini bertujuan 

mengidentifikasi strategi perataan sumber daya manusia yang efektif pada proyek pembangunan 

drainase utama di Kota Palangka Raya serta menganalisis dampaknya terhadap efisiensi penjadwalan 

dan penyelesaian proyek. Hasil penelitian ini diharapkan memberikan kontribusi bagi praktisi dan 

peneliti dalam pengelolaan sumber daya manusia pada proyek konstruksi, khususnya dalam 

mendukung upaya mitigasi banjir di kawasan perkotaan Indonesia.  

Perataan sumber daya merupakan suatu proses yang bertujuan untuk mengkoordinasikan 

pengalokasian sumber daya secara konsisten, dengan tujuan untuk memastikan bahwa jenis dan jumlah 

sumber daya yang dibutuhkan telah teridentifikasi sejak awal dan dapat diakses sesuai kebutuhan (Li 

et al., 2020). Tujuan utama dari perataan sumber daya adalah untuk merencanakan jadwal kegiatan 

dalam suatu proyek dengan mempertimbangkan ketersediaan sumber daya dan pola distribusinya yang 

logis, sehingga durasi proyek tetap terkendali (Iranagh et al., 2023).  Selain itu, dalam proses perataan 

sumber daya, penting untuk mengenali sumber daya yang memiliki keterbatasan dan diperlukan 

sepanjang jalannya proyek. Hal ini dikarenakan alokasi sumber daya yang terbatas memerlukan 

prioritas yang tepat agar proyek dapat berjalan dengan lancar (Alhady et al., 2022). Penjadwalan yang 

telah disusun seringkali tidak memberikan hasil yang optimal. Terdapat hari-hari di mana jumlah 

pekerjaan yang tersedia tidak sebanding dengan jumlah pekerja yang tersedia, sementara pada hari 

lainnya terdapat kebutuhan yang tinggi namun hanya untuk waktu yang singkat, menghasilkan 

fluktuasi yang signifikan dalam kebutuhan tenaga kerja (Eglington & Pavlik, 2020). 

 

Gambar 1.  Pola Distribusi Sumber Daya (a) Bentuk yang tidak Seimbang, (b) Bentuk Meningkat dan 

(c) Bentuk Tetap 
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Kondisi pada Gambar 1(a) menunjukkan ketidakseimbangan distribusi sumber daya, dengan 

surplus tenaga kerja pada awal periode (60 orang) yang tidak termanfaatkan pada tahap berikutnya 

karena kebutuhan menurun menjadi 30 orang. Pengurangan tenaga kerja pada awal periode dapat 

mengurangi pemborosan biaya, namun berisiko menimbulkan kekurangan tenaga saat kebutuhan 

meningkat kembali menjadi 40 orang pada periode selanjutnya. Fluktuasi dalam grafik kebutuhan 

tenaga kerja dapat menimbulkan kerugian bagi perusahaan karena menimbulkan dua pilihan: 

mengalihkan kelebihan tenaga kerja ke proyek lain atau menanggung kerugian akibat pembayaran 

upah tanpa pekerjaan (Ding et al., 2024). Oleh karena itu, penetapan pola distribusi tenaga kerja yang 

ideal menjadi penting untuk meminimalkan risiko dan meningkatkan efisiensi proyek. 

Grafik atau pola distribusi tenaga kerja ideal selama proyek (Mubarak, 2010), adalah sebagai 

berikut: Gambar 1(b), Pola meningkat – Jumlah tenaga kerja rendah pada awal proyek dan meningkat 

secara bertahap seiring kemajuan pekerjaan. Gambar 1(c), Pola konstan – Jumlah tenaga kerja tetap 

stabil dari awal hingga akhir proyek. Gambar 2(a), Pola menurun – Kebutuhan tenaga kerja tinggi pada 

awal proyek kemudian menurun secara bertahap hingga selesai. Gambar 2(b), Pola naik-turun – 

Tenaga kerja meningkat pada pertengahan proyek, lalu menurun kembali secara bertahap hingga akhir 

proyek. 

 

 

 

 

 

 

 

 

 

 

Gambar 2.  Pola Distribusi Sumber Daya (a) Bentuk Menurun dan (b) Bentuk Naik Kemudian 

Turun 

Penyesuaian jadwal diperlukan untuk mencapai grafik tenaga kerja yang optimal, namun 

kegiatan pada jalur kritis sebaiknya tidak diubah karena dapat memperpanjang durasi proyek  

(Hermanto & Widiyarini, 2020). Penyesuaian hanya dilakukan pada kegiatan non-kritis dengan 

memanfaatkan waktu tunda (float) untuk menggeser jadwal maju atau mundur (Muhsinina & Sahid, 

2022). Waktu tunda ini memberikan fleksibilitas bagi perencana dalam mengatur penggunaan tenaga 

kerja secara efisien (Targiel et al., 2018).  Metode perataan sumber daya bertujuan menciptakan pola 

kebutuhan tenaga kerja yang seimbang. Pendekatan ini dilakukan dengan menyesuaikan waktu mulai 

aktivitas antara batas awal dan akhir tanpa mengubah durasi total, menyesuaikan kebutuhan sumber 

daya dengan ketersediaannya, serta memperpanjang durasi proyek bila sumber daya terbatas, 

menggunakan diagram batang tidak kontinu yang memungkinkan jeda antar aktivitas (Ardentius et al., 

2014). 

 

METODE  

Jenis dan Sumber Data 

Data yang digunakan dalam studi ini terdiri atas data primer dan sekunder. Data primer 

diperoleh melalui wawancara tidak terstruktur, observasi lapangan, dan peninjauan metode 

pelaksanaan pekerjaan. Data sekunder berasal dari kontraktor pelaksana, meliputi daftar harga upah 

dan bahan, harga satuan pekerjaan, RAB penawaran dan pelaksanaan, jadwal waktu, hubungan antar 

pekerjaan, jumlah tenaga maksimal, serta gambar rencana proyek. Ada dua metode untuk melakukan 

perataan sumber daya manusia (Hariga & El-Sayegh, 2011), yaitu sebagai berikut:  
1.  Trial-and-error approach 

2.  Blok Schedule 

 

Terdapat dua pendekatan yang sering digunakan dalam melaksanakan perataan sumber daya 

manusia (Pinha & Ahluwalia, 2019; Kastor & Sirakoulis, 2009), yakni: 

1. Metode Tanpa Pertambahan Durasi (No Increase in Duration Method) 
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2. Metode Dengan Pertambahan Durasi (Increase in Duration Method) 

Perataan Sumber Daya Dengan Microsoft Project 

Langkah-langkah membuka dan menyiapkan proyek pada Microsoft Project dimulai dengan 

membuka aplikasi, memilih menu Project → Project Information, lalu mengatur Start Date (misalnya 

22 Februari 2022). Selanjutnya, isi kolom Task Name untuk menambahkan item pekerjaan, tentukan 

durasi tiap pekerjaan, dan lakukan pengelompokan dengan fitur Indent untuk membuat Summary 

Task dan Subtask. Setelah itu, tentukan hubungan antar pekerjaan (Predecessor), buat Resource Sheet 

melalui menu Task atau View Bar, ubah mata uang menjadi IDR melalui File → Options → Display, 

dan ubah unit Max. Units menjadi desimal di File → Options → Schedule. Kembali ke tampilan 

Gantt Chart untuk menempatkan sumber daya, lalu masukkan data melalui Task → Information → 

Resources atau dengan klik ganda pada Task Name. Setelah semua sumber daya dimasukkan, periksa 

alokasinya melalui Team Planner atau Resource Graph. 

 

Berdasarkan grafik Resource Graph, warna merah menunjukkan adanya kelebihan alokasi 

sumber daya pada beberapa jenis tenaga kerja. Untuk mengatasinya, dilakukan perataan sumber daya 

(resource levelling) dengan langkah-langkah berikut: buka menu Resource → Levelling Options, lalu 

pada Levelling Calculations, pilih Automatic dan opsi day-by-day, serta centang Clear Leveling 

Values. Pada bagian Leveling Range, pilih Entire Project, dan pada Leveling Order, pilih Standard. 

Di bagian Resolving Overallocation, hilangkan centang pada Level Only Within Available Slack 

agar penundaan tanggal selesai diperbolehkan, serta pastikan opsi Leveling can adjust individual 

assignments on task tetap dicentang. Setelah itu, klik Level All, konfirmasi pilihan pada Entire Pool, 

dan akhiri dengan menekan OK untuk memulai proses perataan sumber daya. 

 
HASIL DAN PEMBAHASAN 

Analisis Menentukan Kebutuhan Tenaga Kerja 

Analisis upah suatu pekerjaan melibatkan evaluasi jumlah tenaga kerja yang diperlukan dan 

estimasi biaya yang terkait dengan pelaksanaan tugas tersebut (Sholikin et al., 2024; Ferdinand & 

Pamadi, 2023). Estimasi jumlah tenaga kerja didasarkan pada koefisien yang ditentukan dalam Standar 

Nasional Indonesia (SNI) dan Harga Satuan Pekerjaan Konstruksi (HSPK), di mana volume pekerjaan 

dikalikan dengan koefisien yang sesuai dan hasilnya kemudian dibagi dengan target waktu yang 

diinginkan (Endom et al., 2023; Qadir & Ikhsan, 2022; Pranata & HS, 2013). Prosedur ini diterapkan 

pada setiap item pekerjaan untuk memfasilitasi penentuan kebutuhan tenaga kerja dengan lebih efisien, 

sebagai berikut: 

ΣTenaga Kerja = Kuantitas Pekerjaan × Koef Analisa Tenaga Kerja………………………………...(1)  

Berdasarkan data yang diperoleh, proyek konstruksi drainase di Jalan Tingang VI, Kelurahan 

Bukit Tunggal, Kecamatan Jekan Raya, Kota Palangka Raya, Provinsi Kalimantan Tengah, 

melibatkan 23 item pekerjaan yang direncanakan selesai dalam 300 hari, mulai Februari hingga 

Desember. Proyek ini menggunakan empat kategori tenaga kerja, yaitu pekerja, tukang, kepala tukang, 

dan mandor, dengan rincian perhitungan jumlah tenaga kerja disajikan pada Lampiran 1.. 

Menentukan Hubungan Antar Pekerjaan 
Dalam penyusunan jaringan kerja dengan metode Precedence Diagram Method (PDM), 

hubungan antar kegiatan berdasarkan prinsip ketergantungan menjadi hal utama. PDM mencakup 

empat jenis ketergantungan—start to start, finish to start, finish to finish, dan start to finish—dengan setiap 

kegiatan memiliki pendahulu dan pengikut. Rincian hubungan antar tugas serta urutan predecessor dan 

successor disajikan pada Lampiran 2 untuk menggambarkan keterkaitan antar item pekerjaan. 

 

Jumlah Tenaga Kerja Maksimal 
Data jumlah tenaga kerja maksimum diperoleh dari wawancara dengan kontraktor, sedangkan 

jumlah puncak tenaga kerja dihitung menggunakan Microsoft Project, sebagaimana ditunjukkan pada 

Tabel 2. Hasilnya menunjukkan bahwa tenaga kerja yang disediakan kontraktor lebih rendah 

dibandingkan kebutuhan puncaknya. 
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Tabel 2. Jumlah Tenaga Kerja Maksimal dan Puncak (Peak) 
No. Tenaga 

Kerja 

Jumlah 

Maksimal 

Jumlah Puncak 

(Peak) 

No. Tenaga Kerja Jumlah 

Maksimal 

Jumlah 

Puncak (Peak) 

1 Pekerja 80 Orang 89 Orang 3 Kepala Tukang 7 Orang 10 Orang 

2 Tukang 40 Orang 43 Orang 4 Mandor 10 Orang 16 Orang 

Sumber: Hasil Analisis (2025) 

Untuk menghindari penambahan tenaga kerja yang tidak diperlukan, dilakukan optimalisasi sumber 

daya melalui metode perataan menggunakan Microsoft Project, dengan data tenaga kerja maksimum 

dari kontraktor sebagai dasar analisis. Pendekatan ini bertujuan meminimalkan pemborosan biaya 

akibat penggunaan tenaga kerja yang tidak efisien. Hasil wawancara dengan kontraktor menunjukkan 

adanya kelebihan alokasi (overallocation) pada setiap jenis sumber daya, dengan ketersediaan maksimal 

80 pekerja, 40 tukang, 7 kepala tukang, dan 10 mandor. 

Kelebihan Alokasi Sumber Daya Manusia 
Sebelum penyesuaian sumber daya dilakukan, beban kerja tenaga kerja meningkat pada periode 

Agustus hingga November, melebihi alokasi yang tersedia. Analisis menunjukkan adanya kelebihan 9 

pekerja pada Agustus, serta 3 pekerja pada masing-masing bulan September, Oktober, dan November, 

sebagaimana ditunjukkan pada Gambar 3(a).  

 

 

 

 

 

 

 

Gambar 3.  Grafik Alokasi Sumber Daya Pekerja sebelum Perataan Sumber Daya (a) dan Grafik 

Alokasi Sumber Daya Tukang sebelum Perataan Sumber Daya (b) 

 

Perhitungan kelebihan tenaga kerja dilakukan dengan mengurangkan kebutuhan dari kapasitas 

maksimal yang tersedia. Pada Agustus hingga November, kebutuhan pekerja masing-masing 89, 83, 

83, dan 83 orang, sementara kontraktor hanya menyediakan 80 orang, sehingga terjadi kelebihan 9 

orang pada Agustus dan 3 orang pada September–November. Kelebihan alokasi juga terjadi pada 

sumber daya tukang selama Juli hingga November, masing-masing 43, 43, 43, 41, dan 41 orang. 

Dengan kapasitas maksimal 40 tukang, kelebihan mencapai 3 orang pada Juli–September dan 1 orang 

pada Oktober–November, seperti ditunjukkan pada Gambar 3(b). Sementara itu, kepala tukang 

mengalami kelebihan alokasi pada Juli–Desember, dengan kebutuhan 10 orang pada Juli–November 

dan 9 orang pada Desember. Dengan kapasitas 7 kepala tukang, terjadi kelebihan 3 orang pada Juli–

November dan 1 orang pada Desember, sebagaimana terlihat pada Gambar 4(a). 

 

 

 

 

Gambar 4. Grafik Sumber Daya Kepala Tukang sebelum Perataan Sumber Daya (a) dan Grafik 

Alokasi Sumber Daya Mandor sebelum Perataan Sumber Daya (b) 

Perhitungan menunjukkan bahwa kebutuhan kepala tukang sebesar 10 orang pada Juli–

November dan 9 orang pada Desember melebihi kapasitas maksimal 7 orang, sehingga terjadi 

kelebihan alokasi sebanyak 3 orang pada Juli–November dan 1 orang pada Desember. Sementara itu, 

sumber daya mandor juga mengalami kelebihan alokasi pada Februari, Juli, Agustus, September, 

(a) (b) 

(a) (b) 
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Oktober, November, dan Desember, dengan kebutuhan masing-masing 16, 12, 15, 15, 15, 15, dan 11 

orang. Dengan kapasitas maksimal 10 mandor, kelebihan alokasi yang terjadi adalah 6 orang pada 

Februari, 2 orang pada Juli, 5 orang pada Agustus–November, dan 1 orang pada Desember. Grafik 

berwarna merah pada Gambar 4(a) dan 4(b) menunjukkan periode ketika jumlah kepala tukang dan 

mandor melebihi alokasi yang tersedia. 

 

Analisis Perataan Sumber Daya dengan Microsoft Project 

Dari data awal grafik menunjukkan adanya kelebihan alokasi akibat fluktuasi yang tidak 

teratur. Empat jenis sumber daya terlibat dalam proyek pembangunan saluran drainase, yaitu pekerja, 

tukang, kepala tukang, dan mandor, masing-masing dengan peran dan keterampilan berbeda. Grafik 

juga menampilkan perbandingan kondisi sebelum dan sesudah penerapan perataan sumber daya. 

a) Pekerja 
Gambar 5(a) menunjukkan grafik pekerja setelah perataan sumber daya. Terlihat bahwa kelebihan 

alokasi pada bulan Agustus hingga November telah teratasi, dengan puncak aktivitas tidak 

melebihi 80 pekerja per hari. Perbaikan ini dicapai melalui penambahan durasi pada beberapa item 

pekerjaan selama empat bulan tersebut, sehingga pekerjaan dapat diselesaikan lebih merata tanpa 

melebihi alokasi tenaga kerja.  

 

 
Gambar 5.  Grafik Alokasi Sumber Daya Pekerja Sesudah Perataan Sumber Daya (a) dan Grafik 

Alokasi Sumber Daya Tukang Sesudah Perataan Sumber Daya (b) 

Selain itu, grafik menunjukkan bahwa setelah perataan sumber daya dan penyesuaian durasi, 

waktu penyelesaian proyek berubah dari semula bulan Desember menjadi bulan November. Hal 

ini menandakan adanya percepatan penyelesaian proyek dibandingkan jadwal awal. 

 

b) Tukang 
Gambar 5(b) menunjukkan grafik sumber daya tukang setelah perataan sumber daya dilakukan. 

Kelebihan alokasi pada bulan Juli hingga November telah teratasi, dengan puncak aktivitas tidak 

melebihi 40 tukang per hari. Perbaikan ini dicapai melalui penambahan durasi pada beberapa item 

pekerjaan selama lima bulan tersebut, sehingga pekerjaan dapat diselesaikan lebih merata dan 

efisien. Selain itu, grafik memperlihatkan percepatan penyelesaian proyek, di mana durasi yang 

semula berakhir pada Desember kini selesai pada Oktober. 

Gambar 6. Grafik Alokasi Sumber Daya Kepala Tukang Sesudah Perataan Sumber Daya (a) 

dan Grafik Alokasi Sumber Daya Mandor Sesudah Perataan Sumber Daya (b) 

 

c) Kepala Tukang 

Gambar 6(a) menunjukkan grafik sumber daya kepala tukang setelah perataan sumber daya 

dilakukan. Kelebihan alokasi pada bulan Juli hingga Desember telah teratasi, dengan puncak 

aktivitas tidak melebihi 7 orang per hari. Perbaikan ini dicapai melalui penambahan dan 

penyesuaian durasi pada beberapa item pekerjaan selama enam bulan tersebut, sehingga pekerjaan 

(b) (a) 

(b)
)  (a) 

(a)
)  (a) 
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dapat diselesaikan lebih merata tanpa melebihi alokasi. Selain itu, grafik memperlihatkan 

percepatan penyelesaian proyek, di mana durasi yang semula berakhir pada Desember kini selesai 

pada November. 

 

d) Mandor 

Gambar 6(b) menunjukkan grafik sumber daya mandor setelah dilakukan perataan sumber daya. 

Kelebihan alokasi yang sebelumnya terjadi pada bulan Februari hingga Desember berhasil 

dihilangkan, dengan puncak aktivitas rata-rata berada di bawah 10 mandor per hari. Perbaikan ini 

dicapai melalui penambahan dan penyesuaian durasi pekerjaan selama tujuh bulan, sehingga 

alokasi tenaga kerja menjadi lebih merata tanpa kelebihan. Hasilnya, proyek dapat diselesaikan 

lebih cepat berkat pemerataan sumber daya mandor yang efektif, menunjukkan pentingnya 

penerapan perataan sumber daya untuk menjaga efisiensi dan keseimbangan alokasi tenaga kerja. 

Hasil analisis pemerataan sumber daya pada proyek pembangunan saluran drainase di Jalan 

Tingang VI, Kelurahan Bukit Tunggal, Kecamatan Jekan Raya, Kota Palangka Raya menunjukkan 

bahwa durasi awal proyek selama 300 hari dapat dipersingkat menjadi 258 hari setelah dilakukan 

optimalisasi dan pemerataan sumber daya manusia menggunakan Microsoft Project sebagaimana 

tercantum dalam Lampiran 3. Percepatan ini terjadi karena sistem penjadwalan otomatis mampu 

menyeimbangkan alokasi tenaga kerja dan menyesuaikan durasi serta urutan pekerjaan secara efisien. 

Dari 23 item pekerjaan yang dioptimalkan, terdapat 15 item yang mengalami perubahan waktu mulai, 

waktu selesai, dan durasi, sebagaimana tercantum dalam Lampiran 4. Secara keseluruhan, metode 

perataan sumber daya menghasilkan percepatan proyek sebesar 42 hari, menunjukkan bahwa 

penerapan Microsoft Project efektif dalam meningkatkan efisiensi jadwal dan pemanfaatan tenaga kerja 

tanpa mengurangi kualitas pekerjaan. 

 
Rekapitulasi Kebutuhan Tenaga Kerja Rencana dan Sesudah Perataan Sumber Daya 

Sebelum dilakukan optimalisasi sumber daya, jumlah tenaga kerja rencana semula dapat 

dilihat pada Lampiran 5, dan setelah dilakukan optimalisasi sumber daya dengan metode perataan 

sumber daya didapatkan jumlah tenaga kerja seperti dapat dilihat pada Lampiran 6. Berdasarkan pada 

Gambar 7(a), terlihat bahwa setelah dilakukan perataan sumber daya, terjadi fluktuasi dalam jumlah 

kebutuhan pekerja. Terdapat penurunan signifikan pada jumlah pekerja yang direncanakan di bulan 

November, yaitu dari 82 orang menjadi hanya 1 orang setelah perataan sumber daya. Kondisi serupa 

terjadi pada bulan Desember, di mana jumlah pekerja berkurang 66 orang hingga tidak diperlukan lagi 

karena adanya percepatan jadwal. 

 

 

 

 

 

 

 

 

Gambar 7. Perbandingan Pekerja Rencana dan Sesudah Perataan (a) dan Perbandingan Tukang 

Rencana dan Sesudah Perataan (b) 

 Berdasarkan Gambar 7(b), jumlah tukang juga mengalami fluktuasi setelah perataan sumber 

daya. Penurunan tajam terjadi pada bulan November dan Desember, masing-masing dari 41 dan 40 

orang menjadi nol, menunjukkan bahwa percepatan jadwal membuat kebutuhan tenaga tukang pada 

periode tersebut tidak lagi diperlukan. Berdasarkan Gambar 8(a), setelah perataan sumber daya, 

kebutuhan kepala tukang menurun signifikan. Pada bulan November terjadi pengurangan dari 10 

menjadi 1 orang, dan pada Desember dari 9 menjadi nol karena percepatan jadwal membuat tenaga 

kepala tukang tidak lagi dibutuhkan. Sementara itu, pada Gambar 8(b), kebutuhan mandor juga 

mengalami fluktuasi. Pada bulan November terjadi penurunan dari 15 menjadi nol, dan pada Desember 
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dari 11 menjadi nol. Kedua penurunan ini menunjukkan bahwa percepatan jadwal menghilangkan 

kebutuhan tenaga mandor pada bulan-bulan tersebut. 

 

 

 

 

 

Gambar 8. Perbandingan Kepala Tukang Rencana dan Sesudah Perataan (a) dan Perbandingan 

Mandor Rencana dan Sesudah Perataan (b) 

Rekapitulasi Perbandingan Penggunaan Sumber Daya Manusia 
Berdasarkan Berdasarkan data proyek pembangunan drainase pada Tabel 3, penjadwalan awal 

direncanakan selama 300 hari dengan rata-rata sumber daya terdiri atas 51 pekerja, 28 tukang, 7 kepala 

tukang, dan 10 mandor. Setelah dilakukan optimalisasi menggunakan metode perataan sumber daya 

dengan bantuan Microsoft Project, durasi proyek berkurang menjadi 258 hari karena sistem 

penjadwalan otomatis mengatur alokasi waktu secara lebih efisien. 

Tabel 3. Perbandingan Kebutuhan Sebelum dan Sesudah Perataan 

Jenis Kegiatan Durasi (Hari) 
Rata - Rata Resource (Orang) 

Pekerja Tukang 
Kepala 
Tukang 

Mandor 

Rencana 300 51 28 7 10 
Sesudah Perataan 258 58 29 6 8 

Sumber: Hasil Analisis (2025) 

Hasil optimalisasi juga menyesuaikan jumlah tenaga kerja menjadi lebih efektif, yaitu 58 pekerja, 29 

tukang, 6 kepala tukang, dan 8 mandor. Perubahan ini menunjukkan peningkatan efisiensi alokasi 

waktu mulai dan selesai pada setiap kategori tenaga kerja setelah perataan sumber daya dilakukan. 

  

Gambar 9. Grafik Perbandingan Tenaga Kerja Rencana dan Sesudah Perataan 

Berdasarkan pada Gambar 9, setelah dilakukan perataan sumber daya, fluktuasi penggunaan 

tenaga kerja berkurang secara signifikan. Hal ini menunjukkan peningkatan efektivitas penggunaan 

tenaga kerja karena perubahan kebutuhan terjadi lebih bertahap dan seimbang. Penelitian sebelumnya 

menunjukkan bahwa penjadwalan manual tidak mampu mendeteksi ketidakseimbangan sumber daya 

(Isnubroto & Putri, 2021). Penggunaan perangkat lunak seperti Microsoft Project meningkatkan 

kualitas penjadwalan melalui perencanaan dan manajemen yang lebih baik, sehingga menghasilkan 

organisasi aktivitas proyek yang lebih efisien. Grafik hasil perataan ini juga telah sesuai dengan pola 

ideal, yaitu jumlah tenaga kerja meningkat secara bertahap sejak awal proyek, menurun perlahan di 

pertengahan, lalu kembali meningkat hingga akhir proyek (Loleh et al., 2022). 
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Dengan demikian, selisih kebutuhan tenaga kerja antara rencana awal dan setelah perataan 

adalah 1023 – 925 = 98 orang. Berdasarkan Tabel 4, setelah dilakukan optimalisasi sumber daya 

menggunakan metode perataan dengan bantuan Microsoft Project, total kebutuhan tenaga kerja 

berkurang sebanyak 98 orang, menunjukkan peningkatan efisiensi dalam alokasi tenaga kerja. 

 

Tabel 4. Komposisi Kebutuhan Tenaga Kerja Rencana dan Sesudah Perataan 

Jenis Tenaga Kerja 
Jumlah Berdasarkan Rencana 

(Orang) 
Jumlah Berdasarkan Sesudah Levelling 

(Orang) 

Pekerja 549 533 

Tukang 295 268 

Kepala Tukang 72 52 

Mandor 107 72 

Jumlah Total 1023 925 

Sumber: Hasil Analisis (2025) 

SIMPULAN 

Penerapan metode perataan sumber daya manusia dalam perencanaan proyek dapat 

menghasilkan grafik kebutuhan tenaga kerja yang lebih optimal jika dibandingkan dengan grafik 

kebutuhan tenaga kerja rencana pada tahap pelaksanaan proyek yang masih mengalami variasi. Jumlah 

sumber daya sebelum dilakukan perataan sumber daya adalah 1023 OH, sedangkan setelah dilakukan 

perataan sumber daya menjadi 925 OH, dengan selisih sebesar ((1023-925)/1023) × 100% = 9.58% (98 

OH). Jumlah kebutuhan masing-masing jenis sumber daya setelah dilakukan perataan terlihat pada 

grafik kebutuhan tenaga kerja pekerja berkurang sebanyak 549-533 = 16 pekerja, maka diperoleh selisih 

sebesar (16/549) × 100% = 2.91%; kebutuhan tukang berkurang sebanyak 295-268 = 27 tukang, maka 

selisihnya sebesar (27/295) × 100% = 9.15%; kebutuhan kepala tukang berkurang sebanyak 72-52 = 20 

kepala tukang, maka selisihnya sebesar (20/72) × 100% = 27.78%; kemudian kebutuhan mandor 

berkurang sebanyak 107-72 = 35 mandor, maka selisihnya sebesar (35/107) × 100% = 2.71%. Dengan 

hasil tersebut, sumber daya pekerja, tukang, kepala tukang, dan mandor menjadi lebih optimal dan 

terkontrol dibandingkan dengan perencanaan awal proyek tersebut. Meskipun jumlah sumber daya 

menjadi lebih sedikit, namun penyelesaian proyek dapat dilakukan lebih cepat, yaitu 42 hari lebih cepat 

dari durasi yang semula direncanakan oleh pihak proyek, yakni 300 hari menjadi 258 hari. 
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